# Contents

1. Copyright Notice................................................................................................................. 4

2. What is Pack Proof?............................................................................................................. 6
   2.1. The Pack Proof Workflow.............................................................................................. 6
   2.2. Color Management.......................................................................................................... 7
      2.2.1. Devices and Color Spaces....................................................................................... 7
      2.2.2. Devices' Profiles..................................................................................................... 7
      2.2.3. Using Profiles for Color Management..................................................................... 8
      2.2.4. Color Strategies...................................................................................................... 9
      2.2.5. Rendering Intents................................................................................................... 10
      2.2.6. The Color Management Database......................................................................... 12
      2.2.7. PantoneLIVE......................................................................................................... 13
   2.3. Rasterizing Vector Graphics to Bitmaps......................................................................... 13
   2.4. Verification.................................................................................................................... 14
      2.4.1. Choosing Color Deviation Tolerances.................................................................... 14
      2.4.2. Choosing a Verification Strip................................................................................ 17
      2.4.3. Measuring with a Spectrophotometer.................................................................... 20
      2.4.4. Reviewing the Verification Feedback...................................................................... 20

3. Pack Proof Installation and Configuration.............................................................................. 22
   3.1. Licensing....................................................................................................................... 22
   3.2. Installation.................................................................................................................... 22
      3.2.1. Installation or Upgrade?.......................................................................................... 22
      3.2.2. Installation Overview............................................................................................. 23
      3.2.3. Upgrade Overview.................................................................................................. 31
   3.3. Configuration in the Automation Engine Pilot............................................................. 37
      3.3.1. Imaging Engine Configuration for Pack Proof...................................................... 37
      3.3.2. Pack Proof Configuration...................................................................................... 39

4. The Proof for Contract Approval Task................................................................................... 40
   4.1. General.......................................................................................................................... 41
   4.2. Proofer.......................................................................................................................... 43
   4.3. Transformations............................................................................................................ 44
   4.4. PDF Objects................................................................................................................ 46
   4.5. Document Inks............................................................................................................. 47
      4.5.1. Selecting Inks Manually......................................................................................... 48
      4.5.2. Selecting Inks Using Selection Criteria................................................................. 50
      4.5.3. Switching How You Select Inks............................................................................ 52
   4.6. Color Management....................................................................................................... 53
4.6.2. Color Management for Emulation Proof ...................................................... 57
4.7. Output ........................................................................................................... 59
  4.7.1. Color Managing your Proofer’s White Ink .............................................. 65
4.8. Verification ................................................................................................... 66
4.9. Summary ....................................................................................................... 69
1. Copyright Notice

© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986-2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. What is Pack Proof?

Pack Proof is a **proofing software solution** that enables you to proof your jobs on the most commonly used proofers in the market, using the proofers' native language.

Pack Proof is integrated with Automation Engine, so you can send a job through your proofing workflow to the proofer without having to leave the Automation Engine Pilot.

On top of that, Pack Proof ensures **color accuracy**:

- **Color management** ensures color matching throughout your workflow, thanks to Esko's Color Engine Pilot.

- **Verification** allows you to add a color strip to your proof and, if you have a verification license (optional), to verify the strip's color accuracy using a measuring device and the Esko Verification software.

2.1. The Pack Proof Workflow

1. When sending files to Pack Proof's **Proof for Contract Approval task**，you can:
   - Perform general **file transformations** to make sure the output is as expected (select the right page box, rotate/invert/mirror/scale the file as needed...).
   - **Color manage** your file so that your proof accurately reflects what your press output will look like (using color management settings from Color Engine Pilot). See **Color Management** on page 7.
   - **Rasterize** the vector graphics to continuous tone bitmaps (using Imaging Engine's RIP'ing capabilities). See **Rasterizing Vector Graphics to Bitmaps** on page 13.
   - Set **verification** options to later verify your proof's color accuracy using Esko Verification.
2. The **Proof for Contract Approval task** sends the files to be proofed to the **Esko Proof Server**.

3. The **Esko Proof Server** proofs the file on the **proofer** of your choice. This proofer can be one of many types of proofing devices supported by the Esko Proof Server.

4. If you have a verification license, you can verify that the colors on your proof match the colors you were expecting, using a **measuring device** and the **Esko Verification** software.

See the **Esko Verification documentation** for more information.

---

### 2.2. Color Management

Color management is making sure that colors are reproduced consistently at different stages of the printing process.

This consistency is especially important for specific "brand" colors, that have to look the same when printed on different substrates (cardboard, paper, plastic...).

#### 2.2.1. Devices and Color Spaces

Different devices (a digital camera, computer monitor, proofer, press...) display or reproduce colors in different ways.

Colors in photographs are generally defined in the **RGB** color space (Red, Green, Blue), and monitors also use RGB to display colors.

Proofers and presses use **CMYK** (Cyan, Magenta, Yellow and Black - or "Key") for printing, and sometimes additional inks (for example Orange, Green and Blue, to be able to reproduce more colors, or one or two **spot colors** - generally Pantone inks - used in a particular file).

Files coming from a graphic designer may contain CMYK, spot colors and sometimes images in RGB.

#### 2.2.2. Devices' Profiles

Even within one color space, different devices can reproduce colors differently. For example, two CMYK proofers from different brands may print completely differently.

A device's **gamut** is the totality of the colors that device can reproduce (for example, the area shown in light green below).
This is captured in the device's profile, which describes all the colors achieved when using different combinations of percentages from the base colors (RGB, CMYK, or CMYK + extra colors).

To create a profile for a press or proofer, you need to print and measure a profiling chart containing these combinations of percentages.

See the Color Engine Pilot documentation for more information about creating profiles.

Pack Proof support the following types of device profiles:

- Esko profiles, created in the Color Engine Pilot,
- ICC profiles, created in a third party application and written in a standard format.

### 2.2.3. Using Profiles for Color Management

You need to have a profile for each of your devices to perform color management.
Note:
Proofers and presses' profiles need to reflect the device's exact printing characteristics (inks, substrate...).
So if for example you change your substrate, you need to make a new profile taking that substrate into account.

Once you have made the profiles, you can perform a **controlled conversion** of the colors between the different device profiles.

For example if you are printing a photograph, you need to convert its colors from the digital camera's RGB profile (the **source profile**) to the printer's CMYK profile (the **destination profile**).

This means that every color in the source profile is converted to the closest possible color that can be reproduced by the destination profile.

Note:
If you want to proof a file that will be printed on your press, you are trying to reproduce your press' colors on your proofer.
This means that the press profile is your **source** profile, and the proofer profile is your **destination** profile.

### 2.2.4. Color Strategies

If you want to refine your color management, you can use **color strategies**.

A color strategy is a bundle of color management settings that contains at least the source and destination **profiles** of the devices you are using, and can contain other color management settings (for example a **rendering intent** for converting out-of-gamut spot colors and the background color, other settings for converting specific spot colors, etc).

Your company's color management expert can create these color strategies in the Color Engine Pilot, and you can simply select the one you need in your proofing ticket.
For more detailed information about Color Strategies, see the Color Engine Pilot documentation.

2.2.5. Rendering Intents

A Rendering Intent is a part of your color strategy that handles the conversion of out-of-gamut spot colors and of the background color.

Each of the four rendering intents available does this in a different way, so you should choose the one that is more adapted to the way you are printing and the result you want to achieve:

- Use the Relative Colorimetric rendering intent if you don't want to simulate the source background (the point that has 0% of all inks in the source profile).

  This will proof your file as if the proofer substrate was exactly the same as the substrate defined in your source profile.

  For example: your press prints on cream colored card stock whereas your proofer prints on bright white paper, but you don't want to simulate the cream background on your proof.

With this rendering intent, colors from the source profile that cannot be reproduced by the proofer will be converted to the closest color(s) the proofer can reproduce.

In some cases several colors will be converted to the same color, which means that you can sometime lose some detail, especially in dark saturated areas and the dark parts of gradations.
Note that typically the proofer profile has a bigger gamut than the press profile, so there are not many colors that the proofer cannot reproduce.

- **Use the Absolute Colorimetric** rendering intent if you want to simulate the source background to get as exact a color match as possible.

  For example: you do want to simulate the cream colored card stock used on your press on your proofer substrate, to see how the final output will look like (this doesn't only affect the white but all the colors in your file).

As with the Relative Colorimetric rendering intent, colors from the source profile that cannot be reproduced by the proofer will be converted to the closest color(s) the proofer can reproduce, meaning you can sometime lose some detail, although there are typically not many press colors that a proofer cannot reproduce.

- **Use the Perceptual** rendering intent if you are not trying to get an exact color match but want the proof to look visually pleasing.

  If there are colors from the source profile that cannot be reproduced by the proofer, this will shrink the source gamut to fit inside the gamut of the proofer, so that all colors are converted (even the colors already in the proofer's gamut), but the relationship between colors is kept.
This means that colors won't be really accurate, but you won't lose detail in dark saturated areas or gradations.

This rendering intent is most commonly used in commercial printing (for newspapers, magazines, posters...).

- Use the **Saturation** rendering intent if you mostly want to make sure the colors on your proof are saturated enough.

  Colors from the source profile that cannot be reproduced by the proofer will be mapped onto close saturated colors that are in the proofer’s gamut.

  This rendering intent is most commonly used for business presentations containing graphics, or cartoons/comics.

**Note:** You can only use a **Perceptual** or **Saturation** rendering intent if you are working with ICC source and destination profiles.

### 2.2.6. The Color Management Database

All your *profiles, color strategies* and inks are stored in a color management database (also called "CMS database").

You install this color management database when installing Automation Engine. You can install it on your Automation Engine server or on another server (the server you install your color management database on is called the "resources server").

After this, the profiles, color strategies and inks in your color management database are automatically available in the **Proof for Contract Approval task**.
Important:
You should also install the Color Engine Pilot when installing Pack Proof.
This will enable you to create your own profiles, color strategies and inks, and to access PantoneLIVE inks (if you have a PantoneLIVE license).

2.2.7. PantoneLIVE

PantoneLIVE® is a database of Pantone inks in the cloud. It contains information about how different tints of an ink look like, and how the ink will look like on different substrates.

Because it is in the cloud, the same color data is accessible to every actor of the packaging production, globally (while being protected by a login). This ensures that you get predictable and accurate color every step of the way, saving time and costs.

To use PantoneLIVE inks, you need the Color Engine Pilot and a PantoneLIVE license.

After logging on to the PantoneLIVE cloud from the Color Engine Pilot, you will be able to download PantoneLIVE ink books from the cloud, and use PantoneLIVE inks in your files.

Please see the Color Engine Pilot documentation for more information about accessing PantoneLIVE ink books.

Note:
If you don't have a PantoneLIVE license, any PantoneLIVE ink in your files will be treated as an unregistered ink (an ink not present in your color database), and you will not be able to proof or RIP it accurately.

In this case you should ask the file's designer to replace the PantoneLIVE ink by an ink that is present in your color management database.

2.3. Rasterizing Vector Graphics to Bitmaps

Files coming from a graphic designer may contain vector graphics or "linework" (especially for fonts or logos).

Vector graphics are highly scalable without any loss of quality (as they are not based on pixels but on mathematical formulas), but they are not printable.

To be able to print those graphics, you need to rasterize them with a RIP (Raster Image Processor). This means converting them to bitmap images, or "contones" (continuous tone images), which are based on pixels.
Low-resolution bitmaps can look pixellated, but Pack Proof generates high-resolution bitmaps.

2.4. Verification

Once you have color managed and proofed your file(s), you may want to check the color accuracy of your proof. This is especially important for contract proofing, as it is a measure of the proof's quality that you can show your customers.

Provided you have a verification license, you can do this in Pack Proof the following way:

1. Before proofing, you define color deviation tolerances (how close the colors on your proof must be to the colors in your input file for you to accept the proof as color accurate).
2. When proofing your file, you add a verification strip, containing patches of the separations present in your input file.
3. Once your file is proofed, you measure this verification strip in Esko Verification, with a spectrophotometer.
4. In Pack Proof, you get detailed feedback about whether the measured separations are within your tolerances, helping you decide to either accept or reject the proof.

**Tip:** You can also use verification to monitor your proofer's stability over time (for example by printing a test job with a verification strip at regular intervals).

2.4.1. Choosing Color Deviation Tolerances

Quantifying Colors

*The Lab Color Space*

Colors are generally defined by their position in the Lab color space, which is a 3D color model representing all colors visible to the average human eye (developed by the Commission Internationale de l'Eclairage).

It is based on three axes:

- the L axis (going from 0 to 100) defines the lightness of the color (a dark color has a low L value, a light color has a high one),
- the a axis (going from -128 to 128) defines how green or red a color is (a greenish color has a low a value, a reddish color has a high one),
- the b axis (going from -128 to 128) defines how blue or yellow a color is (a blueish color has a low b value, a yellowish color has a high one).
For example:

<table>
<thead>
<tr>
<th>Color</th>
<th>Lab values</th>
</tr>
</thead>
<tbody>
<tr>
<td>light yellow</td>
<td>Lab (100, 0, 60)</td>
</tr>
<tr>
<td>dark green</td>
<td>Lab (15, -128, 0)</td>
</tr>
<tr>
<td>medium gray</td>
<td>Lab (50, 0, 0)</td>
</tr>
</tbody>
</table>

**Difference Between Colors: Delta E**

The difference between two colors is often calculated in **Delta E** (or $A_E$) units: this is the difference between the colors' respective positions on the $L$, $a$, and $b$ axes.
The more different two colors are, the higher the Delta E number is. Generally a human eye can perceive color differences that are above 2 Delta E.

**Note:**

There are several Delta E formulas, that have been developed at different points in time (CIE76, CMC, CIE94 and CIE2000).

- If your company is already using one of those formulas, we recommend that you use the same one.
- If not, you should use CIE2000, which is the best reflection of the visual difference between colors.
- However, if you are trying to verify a proof according to the ISO 12647-7 proofing standard, you should use the formula specified in the standard, CIE76.

**Difference Between Colors: Other Measures**

Apart from Delta E, there are additional color differences indicators, that measure other colors characteristics.

You can use those if you want to have a more comprehensive picture of how well your colors are reproduced, or to quantify a particular color problem of your press.

<table>
<thead>
<tr>
<th>Delta CH</th>
<th>Use this to measure the difference in saturation (or &quot;chroma&quot;) between the colors in your job and the printed colors. This is based on the positions of the two colors on the a and b axes in the Lab color space, and can be a good indication of whether the gray balance on your press is good or not.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delta H</td>
<td>Use this to measure the difference in hue between the colors in your job and the printed colors. The hue is the angle between two colors relative to the a and b axes in the Lab color space.</td>
</tr>
</tbody>
</table>
Delta T Use this to measure the difference in colorimetric tone value between the colors.

Colorimetric tone value means that the dot gain is measured by a spectrophotometer instead of a densitometer.

This gives more information about the colors (for example 50% of a warm yellow and 50% of a cold yellow look the same to a densitometer, but different to a spectrophotometer).

This is only applicable to the primary colors (CMYK).

2.4.2. Choosing a Verification Strip

You can choose from different types of verification strips to add to your job.

Keep in mind that the type of strip you can use depends on:

- what is available on your Esko Proof Server (by default, the Esko Proof Server comes with a large number of strips),
- the spectrophotometer you will use to measure your strip (as different spectrophotometers support different strip types).

This means that depending on your way of working, you will see a certain subset of the strips mentioned below.

Esko Strips

- **Esko Strip**: this strip type contains the following CMYK patches:
  - patches of C, M and Y at 100%, 70% and 40%,
  - overprints of C and M at 100%, 70% and 40%,
  - overprints of C and Y at 100%, 70% and 40%,
  - overprints of Y and M at 100%, 70% and 40%,
  - an overprint of CMYK at respectively 100%, 40%, 40% and 20%,
  - an overprint of CMYK at respectively 40%, 100%, 40% and 20%,
  - an overprint of CMYK at respectively 40%, 40%, 100%, 20%,
  - patches of K at 0%, 20%, 40%, 70% and 100%.
- **Esko + Solid Colors Strip**: this strip type contains the same patches as the Esko Strip type, plus a 100% patch for every spot color present in the job.

  **Note:** When using an **Esko + Solid Colors Strip**, you must color manage your strip.

- **Esko Equinox Strip**: this strip type is only available when you use a *color strategy* containing an Equinox source profile.

  For more information about Equinox, see the *Equinox documentation*.

  **Note:** When using an **Esko Equinox Strip**, you must color manage your strip.

### Industry Standard Strips

- **Fogra strip types**:
  - Fogra MediaWedge V3.0 XE 1Z
  - Fogra MediaWedge V3.0 XE 2Z
  - Fogra MediaWedge V3.0 XE 3Z

  These industry standard strip types are widespread and used to check compliance with the Media Standard Print rules (based on ISO 12647).

  1Z has one line, 2Z has two and 3Z has three.

- **IDEAlliance strip types**:
  - IDEAlliance ISO 12647-7 2009
  - IDEAlliance ISO 12647-7 Control Wedge 2013 (2 lines)
  - IDEAlliance ISO 12647-7 Control Wedge 2013 (3 lines)
  - IDEAlliance ISO 12647-7 Control Wedge 2013 (4 lines)
  - IDEAlliance ISO 12647-7 Control Wedge 2013 (6 lines)

  These industry standard strip types are widespread and used to check compliance with ISO 12647-7.

- **Japan Color strip types**:
  - Japan Color
  - Japan Color 54 (1 line)
  - Japan Color 54 (2 lines)

  These strip types have 54 patches and are used to check compliance with the Japan Color standard.

- **Ugra Fogra strip types**:
  - Ugra Fogra-MediaWedge V2.2
  - Ugra Fogra-MediaWedge V3.0

  These industry standard strip types are widespread and used to check compliance with ISO 12647-7.
They consists of 72 CMYK patches, which correspond to the most important patches of the ECI 2002 color chart.

Other Strips

- **3DAPv3 CMYK Wedge**: this strip type is used to check compliance with the 3DAPv3 proofing specifications (based on ISO 12647-2 and ISO 12647-7).

- **EFI Color Verifier Chart** and **EFI Color Verifier Chart US**: these strip types come with Esko Verification.
  
  The **EFI Color Verifier Chart US** is used to check compliance with the SWOP specifications.

Strip Layouts

For each strip type, several strip layouts are available, each layout being designed for a type of spectrophotometer (i1, i1io, etc.).

Pack Proof automatically uses the correct strip layout, based on the spectrophotometer and strip type you selected.

For example, for the **Esko Strip** type, the following layouts can be used:

<table>
<thead>
<tr>
<th>Spectrophotometer</th>
<th>Strip layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson SpectroProofer</td>
<td><img src="image1" alt="Layout" /></td>
</tr>
<tr>
<td>X-Rite i1io</td>
<td><img src="image2" alt="Layout" /></td>
</tr>
<tr>
<td>HP DesignJet Zx100</td>
<td><img src="image3" alt="Layout" /></td>
</tr>
<tr>
<td>X-Rite i1iSis</td>
<td><img src="image4" alt="Layout" /></td>
</tr>
<tr>
<td>X-Rite SpectroScan</td>
<td><img src="image5" alt="Layout" /></td>
</tr>
</tbody>
</table>
2.4.3. Measuring with a Spectrophotometer

After proofing your job with its verification strip on your Proof Server, you can measure it in Esko Verification with your spectrophotometer.

**Supported Spectrophotometers**

<table>
<thead>
<tr>
<th>Inline</th>
<th>Offline</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Epson SpectroProofer (X-Rite ILS20)</td>
<td>• X-Rite i1Pro 2</td>
</tr>
<tr>
<td>• Epson SpectroProofer (X-Rite ILS30)</td>
<td>• X-Rite i1Pro</td>
</tr>
<tr>
<td>• HP DesignJet Zx100 non UV</td>
<td>• X-Rite i1iO</td>
</tr>
<tr>
<td>• HP DesignJet Zx100</td>
<td>• X-Rite i1iSis UV</td>
</tr>
<tr>
<td></td>
<td>• X-Rite i1iSis</td>
</tr>
<tr>
<td></td>
<td>• X-Rite SpectroScan</td>
</tr>
<tr>
<td></td>
<td>• Barbieri Spectro Swing</td>
</tr>
<tr>
<td></td>
<td>• Barbieri Spector LFP Basic</td>
</tr>
</tbody>
</table>

**Note:**

Make sure the spectrophotometer you want to use is available on your Proof Server!

For example, if you want to measure with an X-Rite ILS30, make sure that the Proof Server workflow you are working with connects to an Epson SpectroProofer that has an X-Rite ILS30 spectrophotometer embedded.

2.4.4. Reviewing the Verification Feedback

**In Pack Proof**

You get feedback in the Pilot's Files and Tasks views:

- When sending the file(s) ready to be proofed to the Proof Server: the **Proof for Contract Approval** task has a **Send to Proof Server** subtask; it has a green check ✅ when the files have been sent to the Proof Server.

- After measuring and verifying your strip: you can see either **Verification successful ✅** or **Verification failed ❌**.

  You can see verification details in the log file (which color deviation tolerances and Delta E formula you used, which tolerances were met or not met...).

**On the Proof**

If you are working with an **inline spectrophotometer**, you can also **print a report** on the proof itself.
This report shows information relative to the proof and verification (the printer used, the date and time, the verification strip used, the tolerances and whether they were met...).
3. Pack Proof Installation and Configuration

3.1. Licensing

To use the Pack Proof functionality in Automation Engine, you need a Pack Proof license (in the form of a product key file).

If you don't have this license, you will not be able to configure Pack Proof in the Automation Engine Pilot, or see the Proof for Contract Approval Task.

For more information about the Pack Proof license, please contact your Esko representative.

3.2. Installation

3.2.1. Installation or Upgrade?

**Software Version**

This document covers the installation of / upgrade to the latest version of Pack Proof (and related applications):

<table>
<thead>
<tr>
<th>Product version</th>
<th>Pack Proof 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current release</td>
<td>Pack Proof November 2018 Release also called Pack Proof 18.0.1</td>
</tr>
</tbody>
</table>

For more information about the released version and build number of each of the applications, please see the Released versions page on the installation DVD.

**Installation or Upgrade?**

If...

- no Esko software has been installed on your computer yet, you need to do a "fresh" installation of Pack Proof 18.0.1.
  
  See Installation Overview on page 23.

- Esko Platform software is installed on your computer, you need to upgrade to Pack Proof 18.0.1 instead.
3.2.2. Installation Overview

To use Pack Proof, you will need to first license then install the following applications:

<table>
<thead>
<tr>
<th>application</th>
<th>before installing, please check:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Engine</td>
<td>the Automation Engine system requirements</td>
</tr>
</tbody>
</table>

**Note:**
- You should have already installed Automation Engine before starting to install the Esko Proof Server and Pack Proof.
- See the Automation Engine installation documentation for details if needed.

<table>
<thead>
<tr>
<th>the Esko Proof Server</th>
<th>the Esko Proof Server system requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pack Proof</td>
<td>the Pack Proof system requirements</td>
</tr>
</tbody>
</table>

You can either install these applications on the same server, or on two or three different servers.

**General installation procedure:**

1. Make sure you have the relevant DVDs.
   - To install the Esko Proof Server, you need the **Esko Software Platform - Proof Server 18.0 installation** DVD.
   - To install Pack Proof, you need the **Esko Software Platform - Imaging Engine 18 installation** DVD.

   **Note:** If you downloaded the software from MySoftware.esko.com, you will need to mount the corresponding .iso files as virtual DVDs, or unpack the .iso files first.

2. Make sure you have the relevant licenses.
   - You need a product key file for Pack Proof 18 (which includes all necessary licenses). If you do not have a product key file yet, contact Esko Customer Support.

3. On all servers on which you want to install Esko software, **prepare for the installation.**

4. On your license server (which can be either your Automation Engine server or a central license server), **activate your licenses.**

5. On the server on which you want to install the Esko Proof Server, perform the steps listed in **Installing the Proof Server** on page 25.

6. On the server on which you want to install Pack Proof, perform the steps listed in **Installing Pack Proof** on page 28.
Preparing for the Installation

Before you install Pack Proof 18.0.1 on your system, check the following:

- You need to have Administrator privileges.
- You need Internet access.
- Your computer must meet the minimum requirements for the installation, as described on www.esko.com/en/SystemRequirements/.
- **Data Execution Prevention (DEP)** must not block the installation. See **How to Change the Data Execution Prevention (DEP) Settings** on page 24.
- The **Password Policy** must not block the installation. See **How to Change the Password Policy** on page 24.
- You must make sure your anti-virus software is not blocking the installation or configuration.

**How to Change the Data Execution Prevention (DEP) Settings**

Data Execution Prevention (DEP) is a security feature that helps prevent damage from viruses and other security threats by monitoring your programs to make sure they use the computer's memory safely.

Before installing Pack Proof, make sure that DEP does not block the installation.

1. In **Control Panel**, click **System > Advanced System Settings**.
2. Click the **Advanced** tab.
3. Under **Performance**, click **Settings**.
4. Click the **Data Execution Prevention** tab.
5. Select **Turn on DEP for essential Windows programs and services only**.
6. Click **OK**.
7. Restart the computer.

**How to Change the Password Policy**

A password policy is a set of rules designed to enhance computer security by encouraging users to employ strong passwords and use them properly.

Before installing Pack Proof, make sure that the password policy on your system does not block the installation.

1. In **Control Panel**, click **Administrative Tools**.
2. In the **Administrative Tools** window, double-click **Local Security Policy**.
3. In the **Local Security Policy** window, double-click **Account Policies > Password Policy**.
4. In the right pane, double-click **Password must meet complexity requirements**.
5. Select **Disabled**.
6. Click **OK**.

**Activating the Licenses**

Pack Proof 18 is protected with licenses. These licenses are distributed as a product key file (in .html).
You need to activate the product keys in the product key file using the **Network License Manager** application, on the server that you are using as a license server (this can be either your Automation Engine server or a central license server).

You should have installed the Network License Manager as part of your Automation Engine installation. See the Automation Engine installation documentation if needed.

You need:

- A product key file for Pack Proof 18 (which includes all necessary licenses). If you do not have a product key file yet, contact **Esko Customer Support**.
- Internet access on the server that you are using as a license server.
- An **Esko ID** in order to activate the licenses. Get one at http://www.esko.com/licensing/CreateAccount.

On the server that you are using as a license server:

1. Open the **Network License Manager**.
   Depending on your OS, you can do this by:
   - going to Start > All Programs > Esko > Network License Manager > Network License Manager,
   - going to Start > Esko > Network License Manager,
   - clicking Network License Manager on your Apps screen.

2. In the **Esko Network License Manager**, do one of the following:
   - drag your product key file in the area marked Drag your Product Key File or your Response file here,
   - click the **Activate** button.

3. Follow the instructions of the **Activate License Wizard**.

4. When asked about the product keys, choose I have received an HTML file containing my Product Keys.

5. Click **Browse** to select the product key file.

6. When asked, fill in your **Esko ID** and **Password**.

7. Click **Finish**.
   The licensed products you can use are now visible in the Network License Manager.

### Installing the Proof Server

You need the **Esko Software Platform - Proof Server 18.0 Installation** DVD for the installation. Use the following procedure to install the Esko Proof Server:

1. Open the **Esko Software Platform - Proof Server 18.0 Installation** window:
   - If you insert the Esko Software Platform - Proof Server 18.0 Installation DVD into the DVD drive, or mount the corresponding .iso file, the window appears automatically.
   - If you unpacked a downloaded .iso file, or if the window doesn't open automatically, double-click setup.exe in the root folder.

2. Select the installation language.

3. Click **Proceed to the installation**.

4. On the **Esko Proof Server 18.0 Installer** page:
a) If you *activated your licences* on a central license server (not the server on which you are installing the Esko Proof Server), connect your Esko Proof Server server to this license server.

See *How to Connect to the License Server* on page 26 for details.
b) Run the system readiness check.

See *How to Perform the System Readiness Check* on page 26.
c) Proceed with the software installation.

See *How to Install the Proof Server* on page 27.
d) If you are installing the Esko Proof Server on a separate server (not your Automation Engine server), make sure that Automation Engine can send files to the Proof Server share.

See *Giving Automation Engine Access to the Proof Server Share* on page 27 for details.

**How to Connect to the License Server**

If you *activated your licences* on a central license server, you need to connect to this license server from your Esko Proof Server.

1. On the *Esko Proof Server 18.0 Installer* page, click on *Install, update or repair the License Server (Network License Manager component)*.

2. Follow the instructions of the installation wizard.

3. Open the *Network License Manager*.

   Depending on your OS, you can do this by:
   1. going to *Start > All Programs > Esko > Network License Manager > Network License Manager*,
   2. going to *Start > Esko > Network License Manager*,
   3. clicking *Network License Manager* on your *Apps* screen.

4. In the *Esko Network License Manager*, go to *Tools > License Client Configuration*.

5. In the *License Client Configuration* dialog:
   a) Enter the name of the server that you are using as a *license server*.
   b) Click *Apply*.
   c) Click *Exit*.

6. Close the *Network License Manager* to go back to the *Esko Proof Server 18.0 Installer* page.

**How to Perform the System Readiness Check**

Before you install the Esko Proof Server, a System Readiness Check is required. This checks whether the operating system is suited for installing and running the Esko Proof Server.

1. On the *Esko Proof Server 18.0 Installer* page, click on *Run the Esko Proof Server 18.0 System Readiness Check*.

2. At the end of the *Readiness Check*, read the resulting messages carefully.

3. If the *Readiness Check* resulted in a problem with:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The password policy</td>
<td><em>Change the password policy.</em></td>
</tr>
</tbody>
</table>
4. Click Exit.

**How to Install the Proof Server**

1. On the **Esko Proof Server 18.0 Installer** page, under Installation or upgrade of the Proof Server component, click Install or upgrade the Proof Server and Profiles components.
2. Follow the instructions of the installation wizard.
   - If the wizard asks you to restart the computer, do so, then relaunch the installation.
3. During the installation of the Esko Profiles, select the proofing devices for which you want to install profiles.
   - If you are not sure which proofing devices you own, you can select Esko Profiles at the top to install all the profiles, but this is not recommended.
4. At the end of the Esko Profiles installation, click Finish.
5. During the installation of the Esko Proof Server, select Server and Client as the features you want to install.
6. At the end of the Esko Proof Server installation, click Finish, and restart your computer as directed by the installer.

**Giving Automation Engine Access to the Proof Server Share**

If you installed the Proof Server on a separate server (that has no other Esko software), you need to make sure that Automation Engine can send files to the Proof Server share.

*Note:* If you installed the Proof Server on the server where Automation Engine is installed, this is done automatically.

Do the following:

1. On the Automation Engine server, check under which user Automation Engine is running.
   - Automation Engine runs as a service under either a local user or a Windows domain user. You can see which user that is:
     - in Automation Engine's Server Admin, under System Account (see the Automation Engine documentation for more details).
     - in your Automation Engine server’s Task Manager (in Processes, select Show processes for all users, and check which user the bgmd.exe process runs under).
   
   *Tip:* By default (if you haven't changed it when/after installing Automation Engine), this is the local user BGSYSTEM, with the default password BGSYSTEM.

2. On the server where you installed the Proof Server, locate the ProofFolder share in which Automation Engine will send files to be printed by the Proof Server.
   - If you used the default installation location (C:\Esko), this is C:\Esko\ProofFolder.
3. Give the Automation Engine user **Full Control** on this share.
   - If the Automation Engine user is a local user:
1. Make sure the same user exists on the Proof Server computer (with the same password).
2. Open the ProofFolder's sharing properties (right-click it, select Properties and go to the Sharing tab).
3. Add the user to the share with full rights (click Share..., type the user name and click Add, select Read/Write as Permission Level and click Share to confirm).
   • If the Automation Engine user is a Windows domain user:
     1. Open the ProofFolder's sharing properties (right-click it, select Properties and go to the Sharing tab).
     2. Add the user to the share with full rights (click Share..., type the user name and click Add, select Read/Write as Permission Level and click Share to confirm).

Installing Pack Proof

You need the Esko Software Platform - Imaging Engine 18 Installation DVD for the installation. Use the following procedure to install Pack Proof 18.0.1:

1. Open the Esko Software Platform - Imaging Engine 18 Installation window:
   • If you insert the Esko Software Platform - Imaging Engine 18 Installation DVD into the DVD drive, or mount the corresponding .iso file, the window appears automatically.
   • If you unpacked a downloaded .iso file, or if the window doesn't open automatically, double-click setup.exe in the root folder.
2. Select the installation language.
3. Click Proceed to the installation.
4. Under Imaging Engine/Pack Proof 18.0 installation, including related tools (Color Pilot, Curve Pilot, HD Flexo Screens and ScreenManager), click Install.
5. On the Imaging Engine 18.0 Installer page:
   a) If you activated your licences on a central license server (not the server on which you are installing Pack Proof), connect your Pack Proof server to this license server.
      See How to Connect to the License Server on page 28 for details.
   b) Check and install the prerequisites.
      See How to Install the Pack Proof Prerequisites on page 29.
   c) Proceed with the software installation.
      See How to Install Pack Proof on page 30.

How to Connect to the License Server

If you activated your licences on a central license server, you need to connect to this license server from your Pack Proof server.

1. On the Imaging Engine 18.0 Installer page, click on Install the Network License Manager 18.0.
2. Follow the instructions of the installation wizard.
3. Open the Network License Manager.
   Depending on your OS, you can do this by:
• going to Start > All Programs > Esko > Network License Manager > Network License Manager,
• going to Start > Esko > Network License Manager,
• clicking Network License Manager on your Apps screen.
4. In the Esko Network License Manager, go to Tools > License Client Configuration.
5. In the License Client Configuration dialog:
   a) Enter the name of the server that you are using as a license server.
   b) Click Apply.
   c) Click Exit.
6. Close the Network License Manager to go back to the Imaging Engine 18.0 Installer page.

How to Install the Pack Proof Prerequisites
Before you install Pack Proof, you need to install the Pack Proof prerequisites.
1. On the Imaging Engine 18.0 Installer page, click on Check and install the Imaging Engine/Pack Proof System prerequisites.
   This checks whether the operating system is suited for installing and running Pack Proof 18, and starts the Pack Proof 18 prerequisites installation.
2. If:
   • you see an error message about the Windows version, your operating system is not suited for running Pack Proof 18.
     Check the System Requirements again and install Pack Proof 18 on a suitable operating system.
   • you see the message Ready to install the prerequisite components for the Imaging Engine software. Do you want to start the installation?, click Yes.
3. The installation wizard for the prerequisite components will check the licenses, list the prerequisite components to install on the system, request confirmation for the installation and then install the required components.
   Follow the instructions of the installation wizard.
   The installation wizard will install the following components:
   • Microsoft Visual Studio Redistributables
   • Message Passing Interface service
   If you are prompted to reboot your computer, do so and restart this installation procedure.
4. If the installer doesn't find a running Automation Engine 18 server on the local machine, you will see the Enter Server name window, prompting you to enter the name of the server running your Automation Engine.
**Note:**

- You should be able to access this server from your Pack Proof machine.
- You can still use the local machine as Automation Engine server (if Automation Engine 18 is installed on it): start up Automation Engine, and leave the field in the **Enter Server name** window blank.

The installer then checks if the server you entered has a running Automation Engine 18 server.

<table>
<thead>
<tr>
<th>If you get the following error:</th>
<th>then:</th>
</tr>
</thead>
</table>
| ERROR - Imaging Engine requires Automation Engine 18.0 The provided master server does not have Automation Engine 18.0 running Checked server: [yourservername] | Automation Engine 18 is not running on the server you entered. 
1. Check that you entered the server name correctly. 
2. Make sure Automation Engine 18 is running on it. 
3. Restart the Pack Proof 18 prerequisites installation. |
| ERROR - Imaging Engine requires Automation Engine 18.0 The provided master server does not have Automation Engine 18.0 installed Checked server: [yourservername] (version [yourserverversion]) | Automation Engine 18 is not installed on the server you entered. 
1. Check that you entered the server name correctly. 
2. Install Automation Engine 18 on it. 
3. Restart the Pack Proof 18 prerequisites installation. |

5. Click **Exit** when the installation wizard is finished.

**How to Install Pack Proof**

1. On the **Imaging Engine 18.0 Installer** page, click **Install the Imaging Engine/Pack Proof 18.0 products**.
2. Follow the instructions of the installation wizard.
3. Read the **End user license agreement** carefully and select **Yes, I accept the license agreement**.
4. When asked to select the products to install on this system, select **Imaging Engine, Color Pilot**, and the desired related products (the products available depend on your license).
   - The **System Components** group cannot be deselected and will be installed on all systems.
   - The products’ **Common Components** that are used by several products (for example the **Color Management System**) will only be installed once (each product’s installer will check if the necessary components are present, and update them if necessary).
Installing Imaging Engine will install the **Proof for Contract Approval task**, and a basic version of Imaging Engine to RIP your files before proofing.

However, if you have also **activated** a full Imaging Engine license, it will install a full Imaging Engine, with the options covered in your license.

5. Select a **Destination Folder** for the chosen products or accept the defaults.
6. At the end of the installation, click **Finish**.

### Installing and Using EPL Files

An EPL linearization file adjusts how your proofer prints to get best results on a certain substrate (it adapts the quantities of inks used so that your proofer can achieve maximum color density without hue shifts).

Esko provides you with a number of EPL files made in controlled conditions for different proofer models and substrate types. We strongly recommend you use the one made for your proofer and substrate combination (before profiling your proofer). This will improve the color accuracy of your proofs.

See [this knowledge base article](https://example.com) to know how to install and evaluate the EPL file(s) made for your proofer series.

### 3.2.3. Upgrade Overview

You can upgrade from any working previous version of Pack Proof or FlexProof/E.

In case you need help with the upgrade (especially from older FlexProof/E versions), contact [Esko Customer Support](https://example.com).

**Note:**

Make sure no users are using the system or are connected to the server.

When upgrading, it is advised that all users save their work and create a backup.

To upgrade Pack Proof, you will need to first license then install the latest version of the following applications:

<table>
<thead>
<tr>
<th>application:</th>
<th>before upgrading, please check:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Engine</td>
<td>the <a href="https://example.com">Automation Engine system requirements</a></td>
</tr>
</tbody>
</table>

**Note:**

You should have already upgraded Automation Engine before starting to upgrade the Esko Proof Server and Pack Proof.

See the Automation Engine installation documentation for details if needed.

| the [Esko Proof Server](https://example.com) | the [Esko Proof Server system requirements](https://example.com) |
Before upgrading, please check:

<table>
<thead>
<tr>
<th>application:</th>
<th>Pack Proof</th>
</tr>
</thead>
<tbody>
<tr>
<td>before upgrading, please check:</td>
<td>the Imaging Engine system requirements</td>
</tr>
</tbody>
</table>

**Note:**

If you have a distributed setup (these applications are installed on two or three different servers), you should keep the same setup for the upgrade.

If you want to change your setup, you should back up your work, uninstall and perform a fresh installation instead.

**General upgrade procedure:**

1. Make sure you have the relevant DVDs.
   - To upgrade the Esko Proof Server, you need the **Esko Software Platform - Proof Server 18.0 Installation** DVD.
   - To upgrade Pack Proof, you need the **Esko Software Platform - Imaging Engine 18 Installation** DVD.

   **Note:** If you downloaded the software from MySoftware.esko.com, you will need to mount the corresponding .iso files as virtual DVDs, or unpack the .iso files first.

2. Make sure you have the relevant licenses.
   - You need a product key file for Pack Proof 18 (which includes all necessary licenses). If you do not have a product key file yet, contact Esko Customer Support.

3. On your license server (which can be either your Automation Engine server or a central license server), activate your licenses.

4. On the server on which you want to upgrade the Esko Proof Server, perform the steps listed in Upgrading the Proof Server.

5. On the server on which you want to upgrade Pack Proof, perform the steps listed in Upgrading Imaging Engine.

**Activating the Licenses**

Pack Proof 18 is protected with licenses. These licenses are distributed as a product key file (in .html).

You need to activate the product keys in the product key file using the **Network License Manager** application, on the server that you are using as a license server (this can be either your Automation Engine server or a central license server).

You should have installed the Network License Manager as part of your Automation Engine installation. See the Automation Engine installation documentation if needed.

You need:

- A product key file for Pack Proof 18 (which includes all necessary licenses). If you do not have a product key file yet, contact Esko Customer Support.
- Internet access on the server that you are using as a license server.
- An Esko ID in order to activate the licenses. Get one at http://www.esko.com/licensing/CreateAccount.
On the server that you are using as a license server:

1. Open the **Network License Manager**.
   Depending on your OS, you can do this by:
   • going to Start > All Programs > Esko > Network License Manager > Network License Manager,
   • going to Start > Esko > Network License Manager,
   • clicking Network License Manager on your Apps screen.

2. In the **Esko Network License Manager**, do one of the following:
   • drag your product key file in the area marked Drag your Product Key File or your Response file here,
   • click the **Activate** button.

3. Follow the instructions of the **Activate License Wizard**.

4. When asked about the product keys, choose I have received an HTML file containing my Product Keys.

5. Click **Browse** to select the product key file.

6. When asked, fill in your Esko ID and Password.

7. Click **Finish**.
   The licensed products you can use are now visible in the Network License Manager.

### Upgrading the Proof Server

You need the **Esko Software Platform - Proof Server 18.0 Installation** DVD for the installation. Use the following procedure to upgrade the Esko Proof Server:

1. Open the **Esko Software Platform - Proof Server 18.0 Installation** window:
   • If you insert the Esko Software Platform - Proof Server 18.0 Installation DVD into the DVD drive, or mount the corresponding .iso file, the window appears automatically.
   • If you unpacked a downloaded .iso file, or if the window doesn't open automatically, double-click setup.exe in the root folder.

2. Select the installation language.

3. Click Proceed to the installation.

4. On the **Esko Proof Server 18.0 Installer** page:
   a) If you are using a central license server, connect to it.
      See How to Connect to the License Server on page 26 for details.
   b) Run the system readiness check.
      See How to Perform the System Readiness Check on page 26.
   c) Proceed with the software upgrade.
      See How to Upgrade the Proof Server on page 34.

### How to Connect to the License Server

If you activated your licences on a central license server, you need to connect to this license server from your Esko Proof Server.

1. On the **Esko Proof Server 18.0 Installer** page, click on Install, update or repair the License Server (Network License Manager component).
2. Follow the instructions of the installation wizard.

3. Open the **Network License Manager**.

   Depending on your OS, you can do this by:
   - going to **Start > All Programs > Esko > Network License Manager > Network License Manager**,
   - going to **Start > Esko > Network License Manager**,
   - clicking **Network License Manager** on your **Apps** screen.

4. In the **Esko Network License Manager**, go to **Tools > License Client Configuration**.

5. In the **License Client Configuration** dialog:
   a) Enter the name of the server that you are using as a *license server*.
   b) Click **Apply**.
   c) Click **Exit**.

6. Close the **Network License Manager** to go back to the **Esko Proof Server 18.0 Installer** page.

### How to Perform the System Readiness Check

Before you install the Esko Proof Server, a System Readiness Check is required. This checks whether the operating system is suited for installing and running the Esko Proof Server.

1. On the **Esko Proof Server 18.0 Installer** page, click on **Run the Esko Proof Server 18.0 System Readiness Check**.

2. At the end of the **Readiness Check**, read the resulting messages carefully.

3. If the **Readiness Check** resulted in a problem with:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The password policy</td>
<td><em>Change the password policy.</em></td>
</tr>
<tr>
<td>The Data Execution Prevention (DEP)</td>
<td><em>Change the DEP Settings.</em></td>
</tr>
</tbody>
</table>

4. Click **Exit**.

### How to Upgrade the Proof Server

1. On the **Esko Proof Server 18.0 Installer** page, under **Installation or upgrade of the Proof Server component**, click **Install or upgrade the Proof Server and Profiles components**.

2. Follow the instructions of the installation wizard.

   If the wizard asks you to restart the computer, do so, then relaunch the installation wizard.

3. The installation wizard may install HotFixes as part of the Proof Server and Profiles components upgrade.

4. At the end of the Esko Proof Server installation, click **Finish**.

### Upgrading Pack Proof

You need the **Esko Software Platform - Imaging Engine 18 Installation** DVD for the upgrade. Use the following procedure to upgrade to Pack Proof 18.0.1:

1. Open the **Esko Software Platform - Imaging Engine 18 Installation** window:
If you insert the **Esko Software Platform - Imaging Engine 18 Installation** DVD into the DVD drive, or mount the corresponding .iso file, the window appears automatically.

If you unpacked a downloaded .iso file, or if the window doesn't open automatically, double-click setup.exe in the root folder.

2. Select the installation language.

3. Click **Proceed to the installation**.

4. Under **Imaging Engine/Pack Proof 18 installation, including related tools (Color Pilot, Curve Pilot, HD Flexo Screens and ScreenManager)**, click **Install**.

5. On the **Imaging Engine 18.0 Installer** page:
   a) If you are using a central license server, connect to it.
      See **How to Connect to the License Server** on page 28 for details.
   b) Check and install the prerequisites.
      See **How to Upgrade the Pack Proof Prerequisites** on page 35.
   c) Proceed with the software upgrade.
      See **How to Upgrade Pack Proof** on page 36.

### How to Connect to the License Server

If you **activated your licences** on a central license server, you need to connect to this license server from your Pack Proof server.

1. On the **Imaging Engine 18.0 Installer** page, click on **Install the Network License Manager 18.0**.

2. Follow the instructions of the installation wizard.

3. Open the **Network License Manager**.
   Depending on your OS, you can do this by:
   a) going to **Start > All Programs > Esko > Network License Manager > Network License Manager**,
   b) going to **Start > Esko > Network License Manager**,
   c) clicking **Network License Manager** on your **Apps** screen.

4. In the **Esko Network License Manager**, go to **Tools > License Client Configuration**.

5. In the **License Client Configuration** dialog:
   a) Enter the name of the server that you are using as a **license server**.
   b) Click **Apply**.
   c) Click **Exit**.

6. Close the Network License Manager to go back to the **Imaging Engine 18.0 Installer** page.

### How to Upgrade the Pack Proof Prerequisites

Before you upgrade Pack Proof, you need to upgrade the Pack Proof prerequisites.

1. On the **Imaging Engine 18.0 Installer** page, click on **Check and install the Imaging Engine/Pack Proof System prerequisites**.
   This checks whether the operating system is suited for installing and running Pack Proof, and starts the Pack Proof prerequisites installation.

2. If:
• you see an error message about the Windows version, your operating system is not suited for running Pack Proof 18.

In this case you need to perform a fresh installation on a suitable operating system instead. Check the System Requirements.

• you see the message Ready to install the prerequisite components for the Imaging Engine software. Do you want to start the installation?, click Yes.

3. The installation wizard for the prerequisite components will check the licenses, list the prerequisite components to install on the system, request confirmation for the installation and then install the required components.

Follow the instructions of the installation wizard.

The installation wizard will install the following components:

• Microsoft Visual Studio Redistributables
• Message Passing Interface service

If you are prompted to reboot your computer, do so and restart this installation procedure.

4. The installer then checks if Automation Engine 18 is running on your Automation Engine server.

<table>
<thead>
<tr>
<th>If you get the following error:</th>
<th>then:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ERROR - Imaging Engine</strong> &lt;br&gt; requires Automation Engine 18.0 &lt;br&gt; The provided master server does not have Automation Engine 18.0 running &lt;br&gt; Checked server: [yourservername]</td>
<td>Automation Engine 18 is not running on the server you entered. &lt;br&gt; 1. Check that you entered the server name correctly. &lt;br&gt; 2. Make sure Automation Engine 18 is running on it. &lt;br&gt; 3. Restart the Pack Proof 18 prerequisites installation.</td>
</tr>
</tbody>
</table>

| **ERROR - Imaging Engine** <br> requires Automation Engine 18.0 <br> The provided master server does not have Automation Engine 18.0 installed <br> Checked server: [yourservername] (version [yourserverversion]) | Automation Engine 18 is not installed on the server you entered. <br> 1. Check that you entered the server name correctly. <br> 2. Install Automation Engine 18 on it. <br> 3. Restart the Pack Proof 18 prerequisites installation. |

5. Click Exit when the installation wizard is finished.

How to Upgrade Pack Proof

1. On the Imaging Engine 18.0 Installer page, click Install the Imaging Engine/Pack Proof 18.0 products.
2. Follow the instructions of the installation wizard.
3. Read the **End user license agreement** carefully and select **Yes, I accept the license agreement**.

4. When asked to select the products to install on this system, select **System Components, Imaging Engine, Color Pilot**, and the desired related products (the products available depend on your license).
   
   - The **System Components** group cannot be deselected and will be installed on all systems.
   
   - The products’ **Common Components** that are used by several products (for example the **Color Management System**) will only be installed once (each product’s installer will check if the necessary components are present, and update them if necessary).
   
   - Installing Imaging Engine will install the **Proof for Contract Approval task**, and a basic version of Imaging Engine to RIP your files before proofing.
     However, if you have also **activated** a full Imaging Engine license, it will install a full Imaging Engine, with the options covered in your license.

5. At the end of the installation, click **Finish**.

### Installing and Using EPL Files

An EPL linearization file adjusts how your proofer prints to get best results on a certain substrate (it adapts the quantities of inks used so that your proofer can achieve maximum color density without hue shifts).

Esko provides you with a number of EPL files made in controlled conditions for different proofer models and substrate types. We strongly recommend you use the one made for your proofer and substrate combination (before profiling your proofer). This will improve the color accuracy of your proofs.

See this knowledge base article to know how to install and evaluate the EPL file(s) made for your proofer series.

### 3.3. Configuration in the Automation Engine Pilot

After installing all the software components required for Pack Proof, you need to launch the Automation Engine Pilot and perform some configuration:

1. Configure the basic version of Imaging Engine that comes with Pack Proof, and that is used for RIP’ing your files.
   
   See **Imaging Engine Configuration for Pack Proof** on page 37.

2. Configure Pack Proof itself.
   
   See **Pack Proof Configuration** on page 39.

#### 3.3.1. Imaging Engine Configuration for Pack Proof

Pack Proof comes with a basic version of **Imaging Engine** for **RIP’ing** the files that you want to proof. You need to configure it the following way:
1. In the Automation Engine Pilot, go to **Tools > Configure**.

2. Select **Imaging Engines** in the left pane.

3. Go to **File > New** or press the **Insert** key (on PC).
   
   This creates an **Imaging1** entry under **Imaging Engines** and shows settings in the right pane.

4. In the right pane's **General** tab:
   
   a) In **Host Name**, enter the name of the server running your Imaging Engine and press **Enter** or **Tab** (or click the **Connect** button next to **Imaging Engine**).
   
   b) Check that you see a green dot with the message **Imaging Engine is up and running**.

<table>
<thead>
<tr>
<th>If you see...</th>
<th>it means that...</th>
</tr>
</thead>
<tbody>
<tr>
<td>a grey dot with the message <strong>Imaging Engine is starting up on host</strong></td>
<td>you need to wait a few minutes before you can use Imaging Engine.</td>
</tr>
<tr>
<td>a red dot with the message <strong>No license for Imaging Engine on host</strong></td>
<td>your Imaging Engine license is missing. Please check your licenses.</td>
</tr>
<tr>
<td>a red dot with the message <strong>No Imaging Engine available on host</strong></td>
<td>the server you have entered doesn't have Imaging Engine or even Automation Engine installed. Please check if you have entered the server name wrong.</td>
</tr>
</tbody>
</table>

You may see other error messages in some cases, but you will always get some advice as to what you need to do (for example with the **Missing resource for Imaging Engine on host** message, you will get advised to **Please reinstall the Imaging Engine**).

**Note:** You can **Stop** and **Start** Imaging Engine from here for troubleshooting purposes, but this is generally not necessary, as Imaging Engine starts automatically, and will restart automatically in case of a crash or after being force quitted.

5. Set the **Number of Workers**. This is the number of parallel processes used to work on multiple pages of a file, or multiple files at the same time.

   **Note:**
   
   The maximum number of workers you can set depends on your license and on the number of cores on your server.

   Please see the **system requirements page** for details.

6. If you are only using Imaging Engine for Pack Proof (you don't have a fully-fledged Imaging Engine to output RIP'ed files), you don't need to configure the **Settings** tab, or the **Queue** tab.

6. In the left pane, select the **Imaging1** entry, go to **File > Rename** and give it a meaningful name.
You can also select it and press F2 on PC.

7. Go to File > Save or use Ctrl+S on PC to save your configuration.

3.3.2. Pack Proof Configuration

This configuration will connect your Automation Engine server (and Pack Proof) to your Esko Proof Server, so that Pack Proof can send files to the Proof Server, for proofing on your device.

For more flexibility, you can connect to several Proof Servers, and have access to all the workflows configured on these Proof Servers. When sending files through the Proof for Contract Approval task, you can then select which workflow of which Proof Server you want to use.

**Important:** You need to perform this configuration before you can use Pack Proof.

1. In the Automation Engine Pilot, go to Tools > Configure.
2. Select Proof Servers in the left pane.
3. For each Proof Server that you want to connect to:
   a) Click Add at the bottom of the right pane.
   b) In the New Proof Server pop-up, enter the name of the server on which your Proof Server is running, and click Add.

   **Note:**
   If you get an error message like The shared folder "ProofFolder" on the host is not writable for the user BGSYSTEM, it means that Automation Engine cannot access the Proof Server share (where it needs to send files to proof).

   In this case, follow the steps in Giving Automation Engine Access to the Proof Server Share on page 27.

   c) In the Status column, check that your Proof Server is Running.

   You also can Remove the connection to a Proof Server if needed.
4. Go to File > Save or use Ctrl+S on PC to save your configuration.
4. The Proof for Contract Approval Task

In your Pack Proof workflow, you can use the Proof for Contract Approval task to:

- Perform general file transformations to make sure the output is as expected (select the right page box, rotate/invert/mirror/scale the file as needed...).
- Color manage your file so that your proof accurately reflects what your press output will look like (using color management settings from Color Engine Pilot).
  
  See Color Management on page 7.
- Rasterize the vector graphics to continuous tone bitmaps (using Imaging Engine's RIP'ing capabilities).
  
  See Rasterizing Vector Graphics to Bitmaps on page 13.
- Set verification options to later verify your proof’s color accuracy using Esko Verification.
  
  See Verification on page 14.

For more information about Esko Verification, please see the Esko Verification documentation.

The Proof for Contract Approval task sends the ready-to-proof files to the workflow of your choice on the Esko Proof Server, who then proofs it on the proofer connected to that workflow. This proofer can be one of many types of proofing devices supported by the Esko Proof Server.

Note:

To use this task, you need to have created a Proof Server workflow in the Esko Proof Client, and that workflow must:

- be connected to the Admin user,
- be connected to a physical proofer (you cannot use the predefined "Esko Linearization" workflow for example).

For information about creating a Proof Server workflow, please see the Esko Proof Client documentation.

Attention:

You can use several Proof Servers, but in this case, make sure that every workflow has a unique name, even across Proof Servers.

If there are workflows with the same name on several Proof Servers, you will not be able to send files to those workflows through Pack Proof.

Task Parameters

In the Device field, select the imaging device that you configured.

Then use the tabs at left to show more settings to fill in. See:

- General on page 41,
- Proofer on page 43,
- Transformations on page 44,
- PDF Objects on page 46,
Using the Proof Server Workflow Parameters

If you are using a **Proof Server workflow** that already has proofing parameters defined (for example the number of copies to print, or the rotation or scaling to apply to your file), those parameters will be filled in by default in the **Proof for Contract Approval** task, so that you don’t have to go check them in the Proof Server workflow and copy them into the task.

**Note:** This is not the case if you are using a SmartName or a public parameter to select your Proof Server workflow.

You can of course change those parameters as desired in the **Proof for Contract Approval** task.

Making a Contract Proof on an Epson SureColor P50x0, P70x0 or P90x0 with the HT Driver

For more information about this, please see [this knowledge base article](#).

### 4.1. General

1. Define what **Page Box** of the input PDF you want to proof.
   
   You can either select **Media Box, Trim Box**, or insert a SmartName [] that must resolve to either media or trim.

   After selecting your file's page box you will see its dimensions under the **Page Box** option.

2. If your input file is a multi-page PDF, select which **Pages** you want to proof:
   
   a) First select **All pages, Odd pages only** or **Even pages only** in the **Pages** option.

   You can also insert a SmartName resolving to either All, Even or Odd.

   b) Then you can refine your selection by entering page numbers or a **Page Range**.

   You can separate page numbers by a comma, or use a dash to indicate a page range (for example 3,6-9). You can also use a SmartName resolving to page numbers and/or page ranges using this same format.
3. **Note:**

   - Page numbers are always physical pages. If your document starts with page 5, you should not use 5 but 1 to get the first page.
   - If you enter page numbers that are not part of your document, they will be excluded from the output (all the other valid pages will be proofed).
   - If you enter the same page(s) more than once (for example 1,1-2), it/they will only be output once.
   - Pages are proofed in the order of the document (entering 5-1 will be automatically changed to 1-5).

3. If you want to invert your output so it is compatible with the output device or software system that will process it, click ![invert](icon.png).

   You can also click ![insert SmartName](icon.png) or **Edit...** to insert a SmartName that must resolve to 1 or true (to invert the output), or to 0 or false (to leave the output as it is).

**Tip:**

   If that setting is already defined in your *Proof Server workflow*, it will be filled in by default. You can of course change it as desired.

4. If you want to mirror your output so it is compatible with the output device or software system that will process it, click ![mirror](icon.png).

   You can also click ![insert SmartName](icon.png) or **Edit...** to insert a SmartName that must resolve to 1 or true (to mirror the output), or to 0 or false (to leave the output as it is).

   If that setting is already defined in your Proof Server workflow, it will be filled in by default. You can of course change it as desired.

5. If you want to add a **SmartMark** to your output file(s), select it in the **SmartMark** list, or use a SmartName that will resolve to the SmartMark name.

   A **SmartMark** is a mark whose content is variable, so you can make it display information about that specific job. For example, you can include some of the parameters used during RIP’ing in your output file(s) by using a SmartMark.

   You need to:

   a) First create the SmartMark you want to use in **PackEdge** (see the **SmartMarks** section in the PackEdge manual for details).

   You can create either:

   - a SmartMark with proof-specific parameters,

<table>
<thead>
<tr>
<th>Use this SmartMark parameter in PackEdge:</th>
<th>to display this value from the Pack Proof parameters:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>the <em>imaging device</em> you used</td>
</tr>
</tbody>
</table>
Use this SmartMark parameter in PackEdge: | to display this value from the Pack Proof parameters:
---|---
Image | whether you *inverted* your output
Emulsion | whether you *mirrored* your output
V Scale | the *vertical scaling* you applied to your output file(s)
H Scale | the *horizontal scaling* you applied to your output file(s)
Color Strategy | the *color strategy* you color managed your input file(s) with
Source Profile | the source profile contained in the color strategy you applied
Destination Profile | the destination profile contained in the color strategy you applied
Resolution | the *resolution* of your output file(s)

- another type of SmartMark (for example a corner mark).

If your PackEdge application is linked to your Automation Engine server, your SmartMark will automatically be saved in the correct location and will be available in Pack Proof.

b) Then select that SmartMark in your **Proof for Contract Approval** task.

The SmartMark will be added to each proof generated from your input file.

### 4.2. Proofer

This is where you select the *Esko Proof Server workflow* to which the task sends your RIP'ed output.

- In the **Proof Server Workflow** list, you can see all of the valid workflows found on the Proof Server(s) you are connected to.
**Note:**
To be valid, your Proof Server workflow must:
- be connected to the **Admin** user,
- be connected to a physical proofer (you cannot use the predefined "Esko Linearization" workflow for example).

For information about creating a Proof Server workflow, please see the *Esko Proof Client documentation*.

Pack Proof checks whether the Proof Server and the selected workflow are available when defining ticket settings and when (re-)launching the task.

The task will end in error if it can't access the Proof Server workflow or if the workflow is invalid.

---

**Attention:**
If you are connected to several Proof Servers, make sure that every workflow has a unique name, even across Proof Servers.

If there are workflows with the same name on several Proof Servers, you will not be able to select any of those workflows here (the name will be greyed out).

You can:
- select a workflow from the list,
- use SmartNames (that must resolve to the name of a valid Proof Server workflow),
- set the workflow using public parameters.

---

**Tip:**
If you select a workflow from the list, its proofing parameters (number of copies to print, rotation or scaling to apply to your file...), will be filled in by default in the **Proof for Contract Approval** task, so that you don't have to go check them in the Proof Server workflow and copy them into the task.

You can of course change those parameters as desired in the **Proof for Contract Approval** task.

---

4.3. **Transformations**

Use the **Transformations** settings to scale or rotate your output relative to your input file.
Tip:
If you are using a Proof Server workflow that already has scaling and/or rotation parameters defined, those parameters will be filled in by default, so that you don't have to go check them in the Proof Server workflow and copy them into the task.
You can of course change those parameters as desired.

1. If you want to **Scale** your input file's contents, select either:
   
   • **Scale by percent** and enter the vertical [ ] and horizontal [ ] scaling percentages to use (they must be between 10% and 100%).

   **Note:**
   By default, you enter the vertical scaling percentage and the horizontal one is calculated automatically to keep the proportions.

   If you want to enter the horizontal scaling percentage manually, click [ ] to unlink it from the vertical one first.

   However, if you do this then link the percentages again, the last percentage you entered will be kept, and the other one will be recalculated automatically to keep the proportions.

   • **Fit to page size** to fit your output to the substrate defined in your Proof Server workflow, while keeping the proportions (this will fit it to either the width or the height of the substrate, while making sure everything is on the substrate).

   • **Fit to page width** to fit it to the width of the substrate defined in your Proof Server workflow, while keeping the proportions.

   If you added SmartMarks to your output, they will be taken into account when fitting the proof to the substrate's width or size.

   **Note:**
   If you have chosen to print borderless in your Proof Server workflow, Pack Proof will take this into account when fitting your output to the substrate, and make your output slightly larger to cover the whole substrate width or height.

   You can only print borderless if your proofing device supports it. Please check the Esko Proof Client documentation and your proofing device documentation for more information about borderless printing.

   If you don't want to scale your file's contents, leave **Do not scale** selected.

   You can use SmartNames resolving to not (Do not scale), ByPercent (Scale by percent), FitSize (Fit to page size) or FitWidth (Fit to page width).

   When entering SmartNames for vertical and horizontal scaling percentages, they must resolve to the numerical value (without the % sign).

2. If you want to rotate your file, select the **Rotation** you want to apply here.

   You can choose to either:
4.4.  PDF Objects

Use the PDF Objects settings to define:

- how to color manage RGB objects in your input file,
- what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files through Shuttle.

1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB object in the input file. The default is srgb.icc.
   
   You can use a SmartName that resolves to the full profile name.
2. Select **Use PDF transfer curves** if you want to use the dot gain compensation curves attached to the images in your input PDF.

These curves compensate for the unwanted characteristics of the device that created the images (scanner, digital camera...).

You can use a SmartName that resolves to true (to use the input file's curves) or false (to not use them).

3. If you experience issues with a font that doesn't look smooth enough at your selected resolution, your font may have **font hinting errors**.

Font hinting is the rendering of the outline (vectorized) font to pixels. For certain fonts, this rendering sometimes doesn't give a visually pleasing result, especially at low resolutions. In the image below, the top font has font hinting errors, the bottom font doesn't.

Choose how to handle files containing font hinting errors:

- Leave **Generate an error if the job contains font hinting errors** selected if you want the task to end in error when encountering font hinting errors. You can also use a SmartName resolving to true.
- Deselect **Generate an error if the job contains font hinting errors** if you want to output your file anyway, whether it has font hinting errors or not (your task will end with a warning). You can also use a SmartName resolving to false.

   This may lead to reduced quality rendering of the text, but it will not generate incorrect characters in your output file.

4.5. **Document Inks**

**Selecting Which Separations to Proof**

Use the **Document Inks** settings to select which separations of the input file(s) you want to proof.

For example, you can use these settings to exclude technical and/or varnish inks from your output.

You can choose to proof either:

- **All** separations.
- **A number of separations you select** manually.
- **A number of separations you select** by using selection criteria.
Selection criteria are rules that you define to select separations automatically for you when the task is launched on a file.

**Tip:** You can make the ink selection parameters public so that an operator can set them through Shuttle as needed for each job.

Selecting separations manually is the easiest option, but you can only do it on a file by file basis (when you launch the task on a single input file).

Using selection criteria is more advanced but also more powerful than selecting separations manually, and you can do it anytime (when launching the task on one or more input files, when using the task in a workflow, when defining ticket settings...).

Therefore, we recommend that you first try selecting separations manually when running the task on individual files, then switch to using selection criteria to automate your workflow further.

**Tip:**
To get used to working with selection criteria, try the following on a few of your files:
1. select the separations you want to output manually,
2. then change **Select Inks** to **by using selection criteria** and see which rules have been created based on your manual selection.

For more information, see *Selecting Inks Manually* on page 48 and *Selecting Inks Using Selection Criteria* on page 50.

**Handling Unregistered Inks**

Unregistered inks are inks that are not present in your color management database. Since there is no information about these inks apart from their RGB values in the input file, they cannot be color managed or proofed accurately.

Therefore, we recommend you exclude them from the output, especially for contract proofing.

Choose what to do in case some unregistered inks are still in the list of inks to be proofed:

- If you want the task to end with a warning, leave **Generate an error if the job contains unregistered inks** deselected.
  
  All the inks you chose to include in the output will be proofed, but the unregistered inks will not be color accurate.

- If you want the task to end in error, select **Generate an error if the job contains unregistered inks**.

In both cases, you will also see a message in the log.

**Note:** If your file contains PantoneLIVE inks and you don't have a PantoneLIVE license, those inks will be treated as unregistered inks.

**4.5.1. Selecting Inks Manually**

**Note:** You can only select inks manually when you are launching the task on a (single) file, not when you are defining a generic ticket without an input file.
When choosing to **Select Inks Manually**, you will see a table containing all of your document’s inks, showing each ink’s:

| Ink Name | If an ink book is not present in your color database, it will show here as `<unregistered *>`.
|----------|--------------------------------------------------|
| Ink Book | The **Ink Index** is the order in which the file's inks will be printed (the ink with ink index 1 is at the bottom of the document and will be printed first).
|          | If your file has several of the same ink, they will have the same ink index, and the next ink will have the next one (for example two Cyans will both have ink index 1, then Magenta will have ink index 2).
|          | This means that when selecting inks for processing, both Cyans will be selected together and handled the same way.
| Tip:     | To find the ink index of a file:
|          | 1. select the file in the Automation Engine Pilot’s **Files** view,
|          | 2. click ![info icon](image)
|          | 3. in the **Info** dialog that opens, select **Inks** in the left panel.
|          | The order of the inks at right is the ink index (the topmost ink has an index of 1, the second of 2, etc.).
|          | Note that if you reorder the inks by one of the columns (for example by **Ink name**), they won't be ordered by ink index anymore. You will need to close that dialog and reopen it to see the ink index order again.
| Spot Ink Index | The **Spot Ink index** is the order in which a spot ink will be printed (when counting only spot inks and not process inks).
|              | For example, if the first 4 inks of the document are CMYK, the first spot ink will have 5 as **Ink Index** but 1 as **Spot Ink Index**.
|              | As for the ink index, if your file has several of the same spot ink, they will have the same spot ink index, and will be handled together when you select them.
| Ink Type | This can be for example Normal, Technical, Varnish...
| Printing Method | If you have set a **Printing Method** for an ink it will be shown here (this can be for example Offset, Gravure, Flexo... or any custom printing method you configured).
|              | See the Automation Engine documentation for more information about printing methods.

Select the ink(s) you want to proof, or select the toggle in the table header to select/deselect all inks.
You will see a table listing the **Selected document inks**, and another table with the **Document inks that are not selected**.

**Attention:** If no ink is selected, you cannot launch the task.

---

### 4.5.2. Selecting Inks Using Selection Criteria

If you don't want to **select inks manually** every time, you can define some rules to automatically select certain inks in your input file(s).

You can do this:

- either when running the task on one or more files, or when creating a task ticket to use later,
- by choosing to **Select Inks by using selection criteria** in the **Document Inks** settings.

**How Does it Work?**

You select the inks to be output by checking a combination of criteria:

1. You define what to check. You can check any of the following ink characteristics in your criteria:

<table>
<thead>
<tr>
<th>Ink name</th>
<th>Ink book</th>
</tr>
</thead>
</table>
| **Ink index** | The **Ink index** is the order in which the file's inks will be printed (the ink with ink index 1 is at the bottom of the document and will be printed first).

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's **Files** view,
2. click 🔄,
3. in the **Info** dialog that opens, select **Inks** in the left panel.

The order of the inks at right is the ink index (the topmost ink has an index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by **Ink name**), they won't be ordered by ink index anymore. You will need to close that dialog and reopen it to see the ink index order again.

| Spot ink index | The **Spot ink index** is the order in which a spot ink will be printed (when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first spot ink will have 5 as **Ink index** but 1 as **Spot ink index**.

| Ink type | This can be for example Normal, Technical, Varnish... |
Pack Proof

| Printing method | If you have set a Printing method for an ink it will be shown here (this can be for example Offset, Gravure, Flexo... or any custom printing method you configured). See the Automation Engine documentation for more information about printing methods. |

For example, you can check whether the Ink book is process, whether the Ink name is yellow...

You can use as many criteria as you want.

2. You define how to combine your criteria into a rule. For example:

   • If you want to output only process yellow, you should check for inks that match both of the criteria:
     
     - Ink book is process
     - Ink name is yellow

   • If you want to output both all process inks and all yellow inks, you should check for inks that match either of the criteria:
     
     - Ink book is process
     - Ink name is yellow

   • If you don’t want to output any process inks or any yellow inks, you should check for inks that match neither of the criteria:
     
     - Ink book is process
     - Ink name is yellow

**How Do I Build Rules?**

Build your rules the following way:

1. Choose how to combine the criteria in your rule:

   • Select **All of the following are true** if you want to only select the inks that match all of the criteria you define.

   • Select **Any of the following are true** if you want to select all the inks that match at least one of the criteria you define.

   • Select **None of the following are true** if you want to only select the inks that match none of the criteria you define.

2. Define your first selection criterion.

   You can select an ink based on its:

   • **Ink name**: you can define if it contains/begins with/ends with/is a piece of text (alphanumerical characters), or if it is empty.

   • **Ink book**: you can define if it contains/begins with/ends with/is a piece of text (alphanumerical characters), or if it is empty.

   • **Ink index**: you can define if it equals/is less than/is greater than the number you enter, or is is between the two numbers you enter (in this case the ink indexes you enter as boundaries are also selected).
• **Spot ink index**: you can define if it equals/is less than/is greater than the number you enter, or is between the two numbers you enter (in this case the spot ink indexes you enter as boundaries are also selected).

• **Ink type**: you can define if it is a piece of text (alphanumerical characters).

• **Printing method**: you can define if it is a piece of text (alphanumerical characters).

<table>
<thead>
<tr>
<th>For example, you could use:</th>
<th>to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>All of the following are true</td>
<td>select all inks from the &quot;designer&quot; ink book</td>
</tr>
<tr>
<td>Ink book is designer</td>
<td></td>
</tr>
<tr>
<td>None of the following are true</td>
<td>exclude an ink called &quot;crease&quot;</td>
</tr>
<tr>
<td>Ink name is crease</td>
<td></td>
</tr>
<tr>
<td>None of the following are true</td>
<td>exclude all technical and all varnish inks</td>
</tr>
<tr>
<td>Ink type is Technical</td>
<td></td>
</tr>
<tr>
<td>Ink type is Varnish</td>
<td></td>
</tr>
</tbody>
</table>

**Tip:**
- You can enter several values to check for: just use a semicolon (:) between them.
  For example, to check for both inks called Cyan and inks called Magenta, choose **Ink name is** and enter Cyan;Magenta.

- When launching the task on a file, you can also click to select one or more of the **Ink names/Ink books/Ink types/Printing methods** used in your input file(s).
  A criterion will automatically be created based on your selection.

3. Click + to add more criteria and define them.
   To remove a criterion, click - next to it.

**Tip:** If you are launching the task on a single input file, you will see a table listing the **Selected document inks**, and another table with the **Document inks that are not selected** under the rules you defined.

**Attention:** If no ink is selected, you cannot launch the task.

### 4.5.3. Switching How You Select Inks

You can switch between the two methods of selecting inks (*manually* and *using selection criteria*), and this will keep the same inks selected.
Switching from Selecting Inks Manually to Selecting Inks Using Selection Criteria

When switching from selecting inks manually to selecting inks using selection criteria, the task will translate your manual ink selection into rules, so that the same inks are selected (you can see them in the **Selected document inks** table).

The rules you get are based on the characteristics of the inks you selected.

For example, if you selected all the process colors but no spot color in your file, for an offset job, you will get the following rule:

**All of the following are true**
- **Ink name** is Cyan;Magenta;Yellow;Black
- **Ink book** is process
- **Ink type** is Normal
- **Printing method** is Offset

**Note:**
If you...
- first selected inks using selection criteria,
- then switched to manual selection without changing the selection,
- then switched back to selection criteria,
... then your rules will be kept.

If you did change the selection in manual mode, the task will automatically generate new rules.

Switching from Selecting Inks Using Selection Criteria to Selecting Inks Manually

When switching from selecting inks using selection criteria to selecting inks manually, all the inks selected by the rules you defined (the inks in the **Selected document inks** table) become selected manually.

**Note:** You can only switch to selecting inks manually when you are launching the task on a (single) file.

4.6. Color Management

This is where you apply *color management* to your output file(s). To do this, you use a *color strategy* containing your color management settings.

You can apply two types of color management, depending on the type of proof you want to make:

**Standard Proof**
If you are making a standard proof, you are trying to reproduce your press' output on your proofer as accurately as possible.

In this case, you should use a color strategy containing your **press profile as source profile** and your **proofer profile as destination profile**.
See *Color Management for Standard Proof* on page 54.

**Emulation Proof**

If you are working with both a regular press and a digital press, and you want to be able to move jobs between presses, you need to make sure they have comparable output.

This can be useful if you want to use your digital press instead of your main press to reprint a few copies of a job, or to print short run jobs (with the same results as on the regular press) in general.

In this case, you should make an **emulation proof**, that takes both presses into account when proofing. It will:

- first simulate how your regular press prints on your digital press,
- then simulate that simulation on your proofer.

This will help you find out which colors can or cannot be reproduced on your digital press, as a digital press can have a narrower gamut than both a regular press and a proofer.

See *Color Management for Emulation Proof* on page 57.

### 4.6.1. Color Management for Standard Proof

If you are making a standard proof, you are trying to reproduce your press' output on your proofer as accurately as possible.

In this case, you should use a color strategy containing your **press profile as source profile** and your **proofer profile as destination profile**.

See *Color Strategies* on page 9 for more information about color strategies.

You can either select an existing color strategy (that you have created in the Color Engine Pilot), or create a new (basic) color strategy on-demand.

Note that when creating a basic color strategy on-demand, you will only be able to use it for the current task (you will not be able to store it, edit it later or reuse it).

- If you have created a color strategy in the Color Engine Pilot, select it in the **Color Strategy** list.

  To be available in this list, your color strategy must be stored in the color database defined for your Automation Engine server (if your Esko software is set up correctly, the Color Engine Pilot saved it in the right place automatically).

  You can also select your desired color strategy through a public parameter, or using a SmartName. The SmartName for the color strategy must resolve to one of the available color strategies.

  The color strategies you can select depend on your proofing device:

  - If your proofing device (connected to the *Proof Server Workflow* you selected) doesn't have a profile attached, you can select any color strategy whose destination profile has the right ink set for the proofer (as shown in red below).
• If your proofing device has a profile attached, you can only select a color strategy that has that profile as destination profile.
Note:

• We recommend you always use a proofer that has been profiled (for more accurate proofing, it should have been profiled or recalibrated within the last two weeks).

You can see when your proofer was last profiled, and manage your profiles, in the Color Engine Pilot's Device Manager. See the Color Engine Pilot documentation for more information.

• If your proofing device has a profile attached and there is a recalibration for this profile, that recalibration will be applied when proofing.

You perform a recalibration when your proofer output has drifted compared to what it was when you created the proofer profile.

To recalibrate the proofer, you print and measure a recalibration chart in the Color Engine Pilot. This creates a recalibration file that you can "apply" on your proofer profile to update it.

For more information about recalibration, please see the Color Engine Pilot documentation.

Tip:

If you are proofing files containing a white separation (for example for a white underprint) on an Epson Stylus Pro WT7900 proofer, and you want to color manage your white separation, make sure you select the color strategy you created for this purpose here.

See White Coloring and Color Managing your Proofer's White Ink for more information.

• If you want to create a basic color strategy on demand:
  a) Select Create Custom Strategy... in the Color Strategy list.
  b) Select a Source Profile and a Destination Profile.

Note:

If your input file contains a document profile, and you want to use that as the source, select Use document profile if available (or use a SmartName resolving to true).

If the input file does not contain a document profile, the Source Profile you selected will be used instead.

Important:

• If your proofing device doesn't have a profile attached, you can use any destination profile that has the right ink set for the proofer.
• If your proofing device has a profile attached, you can only use that profile as destination profile.
• If your proofing device has a profile attached and there is a recalibration for this profile, that recalibration will be applied when proofing.

  c) Select a Rendering Intent.
See Rendering Intents on page 10 for details on how each rendering intent handles the conversion of out-of-gamut spot colors and of the background color, and which to use in which case.

**Note:** You can only use a Perceptual or Saturation rendering intent if you are working with Esko source and/or destination profiles.

d) Click OK.

Once you have selected or created your desired color strategy, the task shows the Source and Destination profiles used in the strategy.

### 4.6.2. Color Management for Emulation Proof

If you are working with both a regular press and a digital press, and you want to be able to move jobs between presses, you need to make sure they have comparable output.

This can be useful if you want to use your digital press instead of your main press to reprint a few copies of a job, or to print short run jobs (with the same results as on the regular press) in general.

In this case, you should make an emulsion proof, that takes both presses into account when proofing. It will:

- first simulate how your regular press prints on your digital press,
- then simulate that simulation on your proofer.

This will help you find out which colors can or cannot be reproduced on your digital press, as a digital press can have a narrower gamut than both a regular press and a proofer.

1. Select Emulation Proof to display color management settings for an emulation proof.

2. Under Analog Press, select your first color strategy 🌈.

   This color strategy should have:

   - your regular press profile 🌈 as Source Profile (or the profile for a printing standard you want to match, for example ISOcoated_V2_eci.icc),

   - your digital press profile 🌈 as destination profile (Emulation Profile).
To be available in this list, your color strategy must be stored in the color database defined for your Automation Engine server (if your Esko software is set up correctly, the Color Engine Pilot saved it in the right place automatically).

You can also select your desired color strategy through a public parameter, or using a SmartName. The SmartName for the color strategy must resolve to one of the available color strategies.

**Note:**

You will only be able to choose a color strategy with a destination profile that is the same as the source profile of the second color strategy.

To choose a color strategy with a different destination profile, you need to first select a second color strategy that has that profile as source profile.


This color strategy should have:

- your digital press profile as **Source Profile**,
- your proofer profile as **Destination Profile**.

To be available in this list, your color strategy must be stored in the color database defined for your Automation Engine server (if your Esko software is set up correctly, the Color Engine Pilot saved it in the right place automatically).

You can also select your desired color strategy through a public parameter, or using a SmartName. The SmartName for the color strategy must resolve to one of the available color strategies.

The color strategies you can select depend on your proofing device:

- If your proofing device (connected to the *Proof Server Workflow* you selected) doesn't have a profile attached, you can select any color strategy whose destination profile has the right ink set for the proofer.
- If your proofing device has a profile attached, you can only select a color strategy that has that profile as destination profile.
**Note:**

- We recommend you always use a proofer that has been profiled (for more accurate proofing, it should have been profiled or recalibrated within the last two weeks).

You can see when your proofer was last profiled, and manage your profiles, in the Color Engine Pilot's Device Manager. See the Color Engine Pilot documentation for more information.

- If your proofing device has a profile attached and there is a recalibration for this profile, that recalibration will be applied when proofing.

You perform a recalibration when your proofer output has drifted compared to what it was when you created the proofer profile.

To recalibrate the proofer, you print and measure a recalibration chart in the Color Engine Pilot. This creates a recalibration file that you can "apply" on your proofer profile to update it.

For more information about recalibration, please see the Color Engine Pilot documentation.

---

### 4.7. Output

Use the **Output** settings to define how many copies of your proof you want, and how to handle images that have a different resolution than the output resolution.

**Note:**

Pack Proof uses the output resolution defined in your Proof Server workflow, where you need to decide whether quality or speed is more important to you.

- If you have chosen **High Quality** in your Proof Server workflow, Pack Proof will output your file(s) at the maximum resolution supported by your proofing device (you can check this resolution in the Proof Client).

  You would typically use this for your final output, where quality is much more important than speed.

- If you have chosen **Standard** in your Proof Server workflow, Pack Proof will output your file(s) at 50% of the maximum resolution supported by your proofing device.

- If you have chosen **Fast**, Pack Proof will output your file(s) at 25% of the maximum resolution supported by your proofing device.

  You would typically use this for drafts, where you don't need high quality yet but want a fast result.

For more information, please see the Esko Proof Client documentation.

1. If you experience problems with jagged edges, for example in small text, you can set an **Anti-aliasing** factor to smooth those edges.

   In the example below, you can see the difference between output without anti-aliasing (on the left), and with anti-aliasing applied (on the right).
You can adjust the amount of anti-aliasing applied by choosing a factor of either 2, 3 or 4 (note that using a higher anti-aliasing factor may slow down processing).

You can also set this with a SmartName resolving to None (if you don't need anti-aliasing), or to the anti-aliasing factor you want (for example 2).

**Attention:** Because anti-aliasing changes the output sampling to smooth the jagged edges, you cannot resample your images (with the **Image Resampling** option) if you use anti-aliasing.

2. If your input file contains images, the images' pixels may not map exactly to output pixels if:
   - the images' resolution is different from the output resolution you chose,
   - scaling and rotation effects change the size and placement of the images' pixels.

In such cases, you need to resample these images to be able to output them at the same resolution as the rest of the file.

In the **Image Resampling** option, choose the resampling method you want to use (you will have to make a trade-off between processing time and image quality).

   - Choose **From File** to use the resampling method defined in the input PDF (this is the default option). This method can be either:
     - the "nearest neighbor" algorithm, which keeps the image very sharp but can make it look jagged (pixellated but sharp). This is mostly recommended if you have small images with sharp lines/sudden differences in intensity, and/or you do not want your images to be fuzzy at all.
This resampling method is very fast.

- the "PDF interpolation" algorithm, that smooths the image while resampling (see below).

**Note:** Most PDF files don't specify a preferred resampling method, so the default ("nearest neighbor" algorithm) is used. If you want to make sure that the "PDF interpolation" algorithm is used, choose **PDF Interpolation** instead of **From File** in the **Image Resampling** option.

You can also use a SmartName resolving to **FromPDF**.

- Choose **PDF Interpolation** to smooth the image while resampling.

With this method, you get images that are pixellated and fuzzy, so it is only recommended if you have small images with gradual differences in intensity, like photographs of nature.
This is slightly less fast.

You can also use a SmartName resolving to PDFInterpolate.

- Choose **Auto Resampling** to upsample the images to an automatically calculated resolution (generally half or a third of the output resolution) before smoothing it.

  When using this, images are a lot less pixellated and fuzzy.
This method is quite slow but gives images of a good quality, so it is recommended in most cases (unless you want an extra sharp image, in which case you should choose From File).

You can also use a SmartName resolving to ResampleAuto.

- Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only slightly fuzzy).
Use this if **Auto Resampling** doesn't give you the results you want.

**Attention:**

Resampling to full resolution can require significant amounts of memory when the output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM available for each worker (see the installation documentation).

You can also use a SmartName resolving to ResampleFull.

3. If you are proofing files containing a white separation (for example for a white underprint), and your chosen *Proof Server workflow* is connected to an Epson Stylus Pro WT7900 proofer, you can tweak how to proof the white objects in your file(s) with that proofer’s white ink.

For example, you can use this to get a cooler or warmer white when printing on transparent or metallic foil.

To do this, select **White Coloring** and choose either:

- **No Coloring** if you just want to print the white objects using the proofer’s white ink, without tweaking the white ink's color.

- **Custom Values** if you want to tweak the color of the proofer’s white ink manually.

  In this case, click **Set Custom Values...** and enter the CMYK values to add to the white ink.

- **Values From Color Management** if you want to use the color strategy you defined in the *Color Management settings* to tweak the proofer’s white ink.
Note:
This color strategy must have a white **Extra Output Ink** (called white) and map the white separation in your file(s) to this white output ink.

See *Color Managing your Proofer’s White Ink* on page 65 for information about how to create such a color strategy in the Color Engine Pilot.

You can also use a SmartName resolving to `NoColoring`, `CustomValues` or `FromColorManagement`.

4. Enter the number of **Copies** you want to print (at least 1).

You can use SmartNames and/or public parameters.

**Tip:**
If the number of copies to print is already defined in your *Proof Server workflow*, that number will be filled in by default.

You can of course change it as desired.

5. Select **Keep job files for relaunch purposes** if you want to be able to proof jobs a second time without having to RIP them again.

In this case, the files created for proofing will not be automatically cleaned up. When you don’t need to keep them anymore, you will have to delete them manually from the `\[Esko Proof Server]\ProofFolder` share.

You can set this option with a SmartName resolving to `true` to keep the files, or `false` to discard them.

**Note:**
To re-proof files that you have kept using this option, do the following:

1. Double-click the **Send to Proof Server** sub-task that was run on the job you want to reuse.
2. This reopens the ticket with a limited number of settings. Change your desired setting as necessary (for example the number of **Copies**).
3. Click **Launch**.

If you didn’t select the **Keep job files for relaunch purposes**, you will see *The job cannot be reprinted as the files from the job were not kept when reopening the ticket.*

**4.7.1. Color Managing your Proofer’s White Ink**

If:
- you are proofing files containing a white separation (for example for a white underprint),
- your chosen *Proof Server workflow* is connected to an Epson Stylus Pro WT7900 proofer,
... you can color manage your proofer's white ink using a color strategy, for example to get a cooler or warmer white on your substrate.

To do this, open the Color Engine Pilot and do the following:

1. Add the following inks to the **designer** ink book:
   - the white separation used in the file you want to proof (for example cool white),
   - a generic white separation, that must be called white.

2. Create a color strategy that will color manage your file's white ink:
   a) Add your generic white ink as an **Extra Output Ink** in your color strategy.
   b) Map your file's white ink (cool white) to your generic white output ink.

   ![Ink Mapping](image)

   c) Make sure that **Ink Mapping...** and **Extra Output Inks...** are selected in your main color strategy dialog.

   **Tip:** If you need more details to perform these steps, please see the *Color Engine Pilot documentation*.

When using this color strategy in Pack Proof, your file's white objects will be color managed so that they are "cool white" on the proof from your Epson WT7900 proofer (and not simply white).

### 4.8. Verification

If you want to **verify the colors on your proof** once you have color managed and proofed your file(s), you can add a **verification strip** and define your **color deviation tolerances** here.

Color verification is especially important for contract proofing, as it is a measure of the proof's quality that you can show your customers.

**Note:** If you have recalibrated your proofing device, that recalibration will be applied to the verification strip too.

See *Color Management* on page 53 for more information about recalibration.

1. Select **Print verification strip** if you want to verify your proof.
   The other settings become available once you have selected this.

2. Select the **Measuring Device** you will use to measure your strip.
See *Measuring with a Spectrophotometer* on page 20 for a list of supported measuring devices.

**Note:** The Epson SpectroProofer ILS20 and ILS30 devices are not supported for measuring proofs with nesting or step and repeat.

### 3. In Strip Type, select the strip you want to print.

The list automatically shows all strips that are available on the *Proof Server Workflow* you selected, and compatible with your *Measuring Device*.

See *Choosing a Verification Strip* on page 17 for more information about the verification strips.

**Note:** Pack Proof automatically uses the correct strip layout, based on the *Measuring Device* and *Strip Type* you selected.

### 4. Select Apply color management to strip if you want to color manage your strip.

Whether you color manage and/or verify your strip depends on what you want to achieve:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Print your strip with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>verify your job's colors</td>
<td>both color management and verification</td>
</tr>
<tr>
<td>leave the verification for later</td>
<td>color management but no verification</td>
</tr>
<tr>
<td>• monitor the proofer's stability over time</td>
<td>no color management but verification</td>
</tr>
<tr>
<td>• compare the output of different proofers of the same model</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** In this case, you will have to manually enter the first proofer's values as reference in Esko Verification when measuring the other proofer's output.

**Note:** If you selected an *Esko + Solid Colors Strip* or an *Esko Equinox Strip*, the strip is always color managed, and the *reference* always set to *Automatically load reference values from source profile*.

### 5. If you have a verification license, the Verify strip (with verification tool) option is available. Select it if you want to verify your strip.

### 6. If you are verifying your strip, you also need to set the following parameters:

a) In the *Reference* list, choose what kind of reference values you are trying to match:
If you are trying to match...

<table>
<thead>
<tr>
<th>then select...</th>
<th>when your verification strip is...</th>
</tr>
</thead>
</table>
| • a standard (for example Ugra/Fogra)  
  • another proofer of the same model  
  • a previous measurement from your proofer (for example measurements from a test chart) | Manually load reference values  
Note: You need to load the standard or measurements manually in Esko Verification.  
either color managed or not color managed |
| an established profile that you are using for color management (for example ISOcoated_V2_eci.icc) | Automatically load reference values from source profile (this is the source profile from your color strategy)  
color managed |
| • the way your proofer prints as defined in its profile  
  • another proofer of the same model (with the same profile) | Automatically load reference values from destination profile (your proofer profile)  
not color managed |

Note:
If you are using a Ugra Fogra-MediaWedge V2.2 or Ugra Fogra-MediaWedge V3.0 verification strip, additional reference values are available (FOGRA11L_MCheck10, FOGRA12L_MCheck10...). Those are also available when you set the Strip Type using a SmartName.

b) Choose the Delta E Formula to use when verifying your strip.

See Difference Between Colors: Delta E on page 15 for more information about Delta E and color differences.

c) To set the color deviation tolerances to use when verifying your strip, click Edit... near Tolerances.

The verification will pass if the color differences are within the tolerances, or fail if they are bigger.

You can fill in:
### General Tolerances
The Delta E tolerances for the color patches and the paper white.

The **Maximum for 95% of all patches** tolerance excludes the worst 5% patches from the calculation.

### Primary Colors Tolerances
The Delta E tolerances for the CMYK patches only.

### Hue Tolerances
The Delta H tolerances for the CMYK, CMYKRGB and Gray patches.

Delta H is the difference in hue between two colors.

The generally accepted Delta H tolerances are a maximum of 1.5 for gray areas, and of 2.5 for primary colors.

### Tone Tolerance
The Delta T tolerance for the CMYK patches.

Delta T is the colorimetric dot gain for primary colors.

The generally accepted Delta T tolerance is a -5% to +5% tone value difference.

### Chromaticness Tolerance
The Delta CH tolerance for the color patches.

Delta CH is the difference in saturation between two colors.

---

See *Difference Between Colors: Delta E* on page 15 and *Difference Between Colors: Other Measures* on page 16 for more information.

d) If you are using an inline measuring device (like an *Epson SpectroProofer* or an *HP Designjet Zx100*), you can choose to print a verification report.

In *Print Inline Report*, select either:

- **Never** to never print any report,
- **Always** to print a report whether the verification succeeds or fails,
- **When verification passes** to only print a report when the verification succeeds.

Once you have proofed your file and verified it in Esko Verification, the report will show information about the proof and verification (the printer used, the date and time, the verification strip used, the tolerances and whether they were met...).

For more information about how to verify your proof’s colors using Esko Verification, please see the *Esko Verification documentation*.

---

### 4.9. Summary

This shows a summary of all the settings you defined in the ticket.
• To show the settings from a tab, click + (on PC) or ▶️ (on Mac) beside the tab name in the right pane.
  Click **Expand All** to show the settings from all tabs.
• To hide the settings from a tab, click - (on PC) or ▼️ (on Mac) beside the tab name in the right pane.
  Click **Collapse All** to hide the settings from all tabs.